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eXtyles Overview
What is eXtyles?
eXtyles is an add-in to Microsoft Word that is used by publishers worldwide to aid in editorial
preparation of publications and conversion of Word files to XML. It is compatible with Word 2003, 2007,
2010, and 2013. It works within 32-bit Office only because Microsoft disabled most VBA add-ins with
64-bit office.
eXtyles has been developed with a mix of VBA (to integrate with Word), VB, C++, Perl, and Omnimark.
The VBA add-in is signed with a certificate from Verisign so that it can be installed within Word at a high
level of trust; though of course, Word macros must be enabled. Installation is completed via a digitally
signed InstallShield installer, and the installer process sets up an additional Verisign security certificate
(owned by Inera) in the registry for eXtyles, along with the signature on the VBA macros.
eXtyles updates are provided through either a completely new installer (generally about once per
year under our maintenance program), or on an as-needed basis with individual patch files for specific
components or data files. Most of our customers have an IT administrator who takes care of running the
installer or installing patch files because administrator permissions are required. eXtyles does not have
any facility for auto-updating over the web, in part to avoid any security concerns or issues.
The only case when eXtyles accesses anything outside of the local PC is to query the PubMed and
CrossRef databases for the purposes of linking bibliographic references, or to verify URLs found in the
Word document. The queries are made via HTTP calls to these services. PubMed is a service run by the
US Government. CrossRef is run by a non-for-profit that is a collective of most of the world’s scientific
and scholarly publishers. In both cases, eXtyles makes a web service call with a small bit of data, and the
returned information is an XML record that is parsed and used by eXtyles.

Where does it install to?
Because eXtyles is an add-in to Word, which itself requires a local installation, the entire eXtyles
application resides on the local client system. eXtyles is a 32-bit application, and so default installation
takes place in c:\Program Files (x86)\eXtyles on a 64-bit Windows system, or c:\Program Files\eXtyles
on a 32-bit Windows system.
During normal operation, eXtyles needs read and execute privileges in the local install directory within
the Program Files directory, but does not need write privileges in the install directory. eXtyles does need
read/write/create privileges within the designated system TEMP directory.
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What version is eXtyles? Or, what’s a build number?
Inera develops eXtyles using Agile practices and Test Driven Development. Because Inera uses these
methodologies, eXtyles is available to our customers on a continuous release cycle — on almost any day,
Inera can release a customized update of eXtyles to any customer that is solid, stable, and incorporates
all of the latest features (and bug fixes!).
To achieve this goal, Inera rebuilds and tests eXtyles every weeknight using the latest code that has been
certified for release. Automated testing is done on the nightly build to reconfirm the integrity of eXtyles.
The automated testing covers virtually every feature of eXtyles and takes more than 80 machine-hours
to complete.
In this environment, traditional software "version numbers" like 1.0.1 or "5.3.6" are not meaningful.
While eXtyles is occasionally given an updated version number to celebrate major new feature
releases (eXtyles is currently at version 6.0.0), the daily "Build" numbers are much more meaningful to
understand exactly what release you have and what features it contains.
Each night, before the new "Build" is created, a master "Build Number" is incremented. eXtyles started
with build number 1 in December 2000, and as of December 11, 2015, eXtyles is at Build 3301. That
means Inera has run the build process more than thirty-three hundred times since eXtyles was first
developed fifteen years ago.
Every eXtyles installer includes the numerical ID of the nightly "build" – or build number – from which
the installer was created.
It is important to be aware of the build number of your current eXtyles installation. When you contact
eXtyles support, we may ask for your current build number so we know what bug fixes or features
are included in your installation. It can also be helpful when we are trying to reproduce problematic
behavior.
The build number is included in the file name of the downloaded zip folder that contains your installer.
You can also find your build number by clicking About button on the eXtyles ribbon.

What about viruses?
Inera takes the threat of viruses very seriously. All PCs at Inera since Inera’s founding have been
protected with anti-virus software. For the last 10 years, we have been using NOD 32, as we find it’s the
best combination of high reliability with no adverse affect on PC performance. All systems at Inera are
set up to auto-update so that the NOD 32 database is kept constantly up-to-date.
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Builds of eXtyles are done on a well-isolated PC to further reduce the risk of virus infection. The build
PC is actually required to have current anti-virus software under the contractual terms of one of our
customers. Because of Inera’s security precautions, you can rest assured that deliveries of eXtyles will be
virus-free

Installation Requirements
General requirements and recommendations
The eXtyles software and hardware requirements and recommendations are as follows:
•

Microsoft Windows (32- or 64- bit): 7, 8, 8.1, or 10

•

Microsoft Word for Windows (32-bit version only): 2007, 2010, 2013, or 2016

•

1024 × 768 screen resolution (minimum)

•

2.5 GHz Intel Core i5 dual-core CPU equivalent or faster
(recommended: systems less than four years old)

•

8 GB RAM (minimum; Inera recommends twice the minimum Microsoft specification for
any combination of Windows and Word)

•

1 GB free HD space to install

•

Internet access for PubMed/CrossRef matching/uploads and URL validation

If you are purchasing new hardware, please keep in mind the following recommendations:
•

Raw CPU speed is the most important factor for eXtyles. Get the fastest CPU you
reasonably can. Adding multiple CPUs or more than two cores doesn’t add any speed if
eXtyles is the only process you’re running because eXtyles is not multi-threaded

•

Make sure you have a "reasonable" amount of RAM. You don’t need to go overboard,
but you also don’t want bare-bones. We usually recommend double what Microsoft
recommends for the combination of Windows and Office on the given OS. Again, you
may need more if other processes also run on the system

•

We recommend a Solid State Drive rather than a hard drive these days because
reliability has improved through the years, and we do see a performance difference
running eXtyles.
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Up-to-date installation requirements and recommendations can also be found on our Support site.1
Note: eXtyles supports 64-bit Windows, but does not support 64-bit Microsoft Office.

Verifying your installation
After installing eXtyles on a computer, it is important to verify that eXtyles is working as expected.
Microsoft Word settings, Windows settings, anti-virus software configurations, and other installation
mishaps can silently interfere with your eXtyles installation, and the amount of interference can change
as updates are continually pushed into your system. For this reason, we recommend confirming that
eXtyles and all of its components have been successfully loaded after every installation.
Inera has developed a generic test that will help you confirm that eXtyles is installed and running
correctly. The instructions are written for IT professionals and other users who are not yet familiar with
the eXtyles interface or its functions. The test instructions, eXtyles Installation Verification.doc, can be
downloaded from the Inera Additional Guides page.2

64-bit Office woes
32-bit applications, including eXtyles, are not compatible with 64-bit versions of Office. You can find
technical details about this limitation in the Microsoft articles, Compatibility Between the 32-bit and
64-bit Versions of Office 20103 and 64-bit Editions of Office 2013.4
Note the Microsoft recommendation:
"We recommend the 32-bit version of Office, because it is more compatible with most
other applications, especially third-party add-ins."
It’s unlikely that most organizations need the additional capacity within Word that is provided by moving
to the 64-bit version. When there are users within an organization who need to do CPU-intensive
spreadsheet or database work, it’s actually possible to install the 64-bit versions of Excel and Access in
parallel with the 32-bit versions of Word and Outlook. This approach can satisfy the needs of all users in
an organization, and provide additional capabilities of products like eXtyles within your publishing team.

1

https://support.extyles.com/solution/articles/1000178066-extyles-installation-software-and-hardware-

requirements
2

http://www.inera.com/support/additional_guides

3

https://msdn.microsoft.com/en-us/library/ee691831%28office.14%29.aspx

4

https://technet.microsoft.com/library/ee681792(v=office.15).aspx
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Word 2013: Slow application performance
Recently, an eXtyles customer reported to our support team that eXtyles Cleanup seemed to take
considerably more time to process long documents in Word 2013, compared with processing the same
document in Word 2010. Tests by Inera support staff confirmed that Cleanup does indeed take longer in
Word 2013.
Concerned that the Cleanup code might need to be optimized to improve performance in Word 2013,
we investigated the timing difference in more detail to try to identify the particular Cleanup option that
was causing the process to run more slowly.
We were quite surprised to discover that almost all Cleanup options took longer to run in Word 2013
than in Word 2010. The difference in timings varied from approximately 50% longer to twice as long in
the newer version of Word.
A cursory search on the Internet reveals that we are not alone. We found several forum posts
complaining of poor performance of add-ins not only in Word 2013, but also in Excel 2013 and other
Office 2013 applications compared with earlier Office versions. Visual Basic for Applications (VBA), the
language used by many Office applications to access information in Office documents, is used to perform
most Cleanup functions and a few other eXtyles operations.
Of particular concern to the eXtyles support team was an experience reported in an Office forum.5 A
developer opened a support case with Microsoft because his VBA application was taking between five
and eight times as long to run in Word 2013 compared with Word 2010. He reported that "Microsoft
have acknowledged shortcomings in the performance of Word 2013" to the extent that they had waived
the usual fee for Microsoft developer support, and the Microsoft support engineer had reported the
problem to the Word development team. Although this experience was posted in May 2013, it appears
that Microsoft has not taken steps in the intervening two years to address the VBA performance issues
in Word 2013.
Fortunately most eXtyles functions rely only minimally on VBA, so the largest impact is in the eXtyles
Activation and Cleanup functions; there is a much smaller impact on Auto-Redact, Advanced Processes,
and Export. However the problem remains, and since it appears that Microsoft has been either unable or
unwilling to address the issue with updates to Word 2013, we advise users who are concerned about the
performance of eXtyles (and other custom Word macros) to avoid upgrading from Word 2010 to Word
2013 unless there are other compelling reasons to do so.

5

https://social.msdn.microsoft.com/Forums/office/en-US/e2e04c42-0844-4e04-bcc6-851809a64da6/

what-is-broken-in-word-2013-vba?forum=worddev
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Office 2016 is due to be released later this year. It remains to be seen whether the original VBA
performance will be restored in this new version. A query to this effect6 to the Microsoft developers
posted five months ago on a forum for Office 2016 beta testers still awaits an answer...
Update: The VBA performance issue is not resolved in Office 2016. Because of this issue, we continue to
recommend the use of Office 2010

Is eXtyles compatible with Office 365?
Short answer: Yes, provided you have licensed a version of Office 365 that includes the full Office
Desktop Suite
Longer answer: Office 365 a suite of products from Microsoft that introduces a new software "rental"
model rather than the traditional perpetual license model. So the name "Office 365" refers to a licensing
model rather than a specific version of Microsoft Office. Most versions of Office 365 include the full
Office Desktop Suite, including Microsoft Word.
eXtyles works as a Word add-in to the Office Desktop Suite. eXtyles fully supports Office 365 when you
have purchased a version of Office 365 that includes the full Office desktop (e.g. Office 365 Business,
Office 365 Business Premium, Office 365 Home), and when you have installed the full Office desktop on a
traditional Windows laptop or desktop PC. eXtyles does not support mobile versions of Office running on
a tablet or smartphone.

MathType
eXtyles makes use of a third-party application called MathType to produce MathML and image files of
equations in a Word document. Developed by Design Science, MathType is a Word add-in that provides a
full-featured interactive equation editor. In fact, the built-in Microsoft Equation Edit 3.0 feature of Word
is a subset of MathType licensed by Microsoft from Design Science. However Equation Edit 3.0 lacks
features required by eXtyles.
eXtyles detects installations of MathType, and makes direct calls to the MathType engine when exporting
equations to XML. These calls may generate MathML, TeX, and/or .eps or .gif files of the equations. Both
the file pointers for the image files and the MathML are included in the eXtyles-generated XML.

6

https://blogs.office.com/2015/02/04/next-chapter-office-windows/
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For organizations that wish to produce MathML and/or image files for their equations, MathType is a
required addition to eXtyles. MathType7 can be purchased directly from Design Science for $97.00; site
licenses8 are available by request.

Common Installation Problems
eXtyles is installed, but is not showing up in Word
If the eXtyles installation finishes with no errors, and you have an eXtyles folder in Program Files or
Program Files (x86) but eXtyles does not show up in Word, please check the following items:

Are all macros disabled?
eXtyles uses several macros, and so macros must be enabled in Word.
To enable macros in Word 2007 and newer:
1. Navigate to File > Options > Trust Center > Trust Center Settings > Macro Settings
2. Select Enable All Macros, and click OK.
3. Restart Word.

Is an eXtyles file listed as a Disabled Item?
Occasionally, the eXtyles menu fails to appear after installation because of Word’s macro security
setting. Note that when this problem occurs, users have typically installed eXtyles successfully once or
twice before. This problem can also occur if Word crashes (silently or not).
To re-enable these files in Word 2007 and newer:
1. Navigate to File > Options > Add-ins > Manage, select Disabled Items, and click OK.
2. Select "omml.dot", "icehook.dotm", or "extend.dot" if any are listed under Word’s list of
Disabled Items, and click Enable
3. Restart Word.

7

http://www.dessci.com/en/products/mathtype/default.htm

8

http://www.dessci.com/en/products/mathtype/site/default.htm
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Did Word forget where the Startup directory is?
Several important eXtyles macros are installed to the Word Startup directory; however, if Word has lost
track of where that directory is, then eXtyles will not load.
If you are running Word 2013:
1. From the File tab on the Word ribbon, click: Options > Trust Center > Trust Center
Settings > Trusted Locations > Add new location...
2. Add the path C:\Program Files (x86)\Microsoft Office\Office15\STARTUP\ if you are
running 64-bit Windows
3. Add the path C:\Program Files\Microsoft Office\Office15\STARTUP\ if you are running
32-bit Windows
If you are running Word 2010:
1. From the File tab on the Word ribbon, click: Options > Trust Center > Trust Center
Settings > Trusted Locations > Add new location...
2. Add the path C:\Program Files (x86)\Microsoft Office\Office14\STARTUP\ if you are
running 64-bit Windows
3. Add the path C:\Program Files\Microsoft Office\Office14\STARTUP\ if you are running
32-bit Windows
If you are running Word 2007:
1. Click the Microsoft Office Button, then click: Options > Trust Center > Trust Center
Settings > Trusted Locations > Add new location...
2. Add the path C:\Program Files (x86)\Microsoft Office\Office12\STARTUP\ if you are
running 64-bit Windows
3. Add the path C:\Program Files\Microsoft Office\Office12\STARTUP\ if you are running
32-bit Windows

Is icehook missing from the Word startup directory?
Check to see that icehook.dotm* is listed in the Word STARTUP directory (see above section for the
appropriate file path for your environment). If icehook is not listed, copy icehook.dotm from the eXtyles
directory and paste it into the STARTUP directory.
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Have you tried turning it off and on again?
Occasionally, rebooting the machine may reload files to their correct location, refresh a corrupted file, or
resolve an issue in other mysterious ways.

Error message in Word: your license has expired
When using eXtyles activated with a softkey, not a hardware key: please make sure you typed the
serial number correctly during installation.
When using eXtyles activated with a hardware key: please note that the HASP key must be plugged
into the machine that is using eXtyles during eXtyles processing. The red light on the key should be lit. If
you are running Windows on a virtual machine, make sure the VM recognizes the HASP key.
Note: If your organization has multiple keys, you cannot install with one key and then swap another one in
-- the install process remembers which key has been used during install.
These and other common issues are covered on the Inera Installation Support page9.

InstallShield Error
InstallShield is used to manage the installation and uninstallation of eXtyles. Occasionally, particularly
during the installation of an eXtyles update, certain InstallShield components prevent you from
successfully installing a new version eXtyles. Solutions for common InstallShield errors are listed below:

iKernel.exe could not be installed
The warning message may say:

The InstallShield Engine (iKernel.exe) could not be installed. IKernel.exe could
not be copied to ‘C:\Program Files\Common Files\InstallShield\Engine\6\Intel 32’
Make sure that you have the appropriate privileges to copy files to this folder.
There are several possible reasons that the InstallShield Engine could not be installed.
1. Admin privileges are required
Even if you are logged in as an administrator, you may need to explicitly install eXtyles as an
Administrator. To do this, right-click the eXtyles executable file (e.g., eXtyles for Your Organization.exe)
and select "Run as Administrator." The eXtyles installation process should run normally.
9

https://support.extyles.com/a/solutions/folders/1000213844
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2. IKernel.exe is still running
Sometimes iKernel.exe failed to close properly after the last installation or uninstallation of eXtyles.
Check if a copy of iKernel.exe is running, and if so, end the task. To do this:
1. Press CTRL + ALT + DELETE
2. Select Task Manager
3.

Select the Processes tab

4. Look for IKernel.exe in the list of processes. If it is running, select it, and click End
Process.
5. Select Yes to the Task Manager Warning dialog.

An error -5006 occurred while running the setup.
The warning message may say:

An error (-5006: 0x800700b7) has occurred while running the setup. Please make
sure you have finished any previous setup and closed other applications. If the
error still occurs, please contact your vendor: Inera Inc.
We have seen cases where major commercial virus scanners interfered with the installation process. If
you are seeing this warning, try disabling your virus scanner (or making the settings less aggressive) and
then try installing again.

Interference from Anti-virus Software
Some anti-virus software can prevent eXtyles from installing or running correctly. Even though all major
components of eXtyles include a trusted digital signature, some security programs will deem core
eXtyles components "malicious" and place them in quarantine. The absence of these components results
in a fatal error when the user opens Word or runs an eXtyles Advanced Process. When this happens, the
two most common errors messages that the user sees are:
•

"compile error in hidden module o12_eXtylesRibbon"

•

"omnivm.exe has stopped working"

Anti-virus software may put the entire eXtyles directory in quarantine, put one or more core eXtyles
components in quarantine, or remove core components without listing them in quarantine at all.
Therefore, it is important to review both the quarantine list and the eXtyles directory for listed core
components.
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The minimal required set of .exe, .dll, .dot, and .dotm files required by eXtyles that might be subject to
quarantine by anti-virus software are listed below. Be sure each file exists in the eXtyles directory and is
not listed on your anti-virus software’s quarantine list.
Directory
C:\Program Files\eXtyles\
C:\Program Files\eXtyles\
C:\Program Files\eXtyles\
C:\Program Files\eXtyles\Perl\
C:\Program Files\eXtyles\RXP\
C:\Program Files\eXtyles\
C:\Program Files\eXtyles\
C:\Program Files\eXtyles\
C:\Program Files\eXtyles\
C:\Program Files\eXtyles\
C:\Program Files\eXtyles\
C:\Program Files\eXtyles\
C:\Program Files\eXtyles\
C:\Program Files\eXtyles\
C:\Program Files\eXtyles\
C:\Program Files\eXtyles\
C:\Program Files\eXtyles\
C:\Program Files\eXtyles\
C:\Program Files\eXtyles\
C:\Program Files\eXtyles\
C:\Program Files\eXtyles\
C:\Program Files\eXtyles\OMServer\
C:\Program Files\eXtyles\OMServer\
C:\Program Files\eXtyles\OMServer\
C:\Program Files\eXtyles\OMServer\
C:\Program Files\eXtyles\OMServer\
C:\Program Files\eXtyles\OMServer\
C:\Program Files\eXtyles\
C:\Program Files\eXtyles\
C:\Program Files\eXtyles\
C:\Program Files\eXtyles\

Type
EXE
EXE
EXE
EXE
EXE
DLL
DLL
DLL
DLL
DLL
DLL
DLL
DLL
DLL
DLL
DLL
DLL
DLL
DLL
DLL
DLL
DLL
DLL
DLL
DLL
DLL
DLL
DOTM
DOTM
DOT
DOT

File
CopyKey.exe
eXdiagnoseEXE.exe
omnivm.exe
PERL.EXE
RXP.exe
Attributes.dll
CitStyles.dll
CoreParser.dll
DocInfo.dll
Events.dll
eXdiagnoseDLL.dll
ExtendDLL.dll
IneraStats.dll
Keystone.dll
LaunchApp.dll
MemFile.dll
parstyle.dll
PathGen.dll
RevParser.dll
RulesManagement.dll
TabLoad.dll
ombcd.dll
omfsys.dll
omioprot.dll
omtcp.dll
omutil.dll
XprocLib.dll
eXtylesRibbon.dotm
icehook.dotm
extend.dot
icehook.dot

To avoid interference from your anti-virus software, add eXtyles to your anti-virus software’s exclusion
list. This should prevent the software from putting eXtyles components in quarantine.
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Uninstalling eXtyles
Before installing a new build of eXtyles, be sure to uninstall the previous build using Word’s Add/Remove
Programs tool, accessible through the Control Panel. After successfully uninstalling eXtyles, check in c:\
Program Files x86 (or c:\Program Files if you are running 32-bit Windows) to make sure all eXtyles files
have been removed. If the eXtyles directory or any eXtyles files remain, delete them.

Uninstalling eXtyles by hand
On 64-bit Windows:
1. Delete the directory C:\Program Files (x86)\eXtyles; or, if you can’t delete it, make sure
it’s empty
2. Search for any copies of icehook.dot and icehook.dotm on your C: drive (or, in the
directory where Program Files (x86) is located if not C: ) and delete them
3. Using regedit, find these registry keys and delete them and all their contents:
•

HKEY_LOCAL_MACHINE\SOFTWARE\WoW6432Node\Inera

•

HKEY_CLASSES_ROOT\Inky

On 32-bit Windows:
1. Delete the directory C:\Program Files\eXtyles; or, if you can’t delete it, make sure it’s
empty
2. Search for any copies of icehook.dot and icehook.dotm on your C: drive (or, in the
directory where Program Files is located if not C: ) and delete them
3. Using regedit, find these registry keys and delete them and all their contents:
•

HKEY_LOCAL_MACHINE\SOFTWARE\Inera

•

HKEY_CLASSES_ROOT\Inky

You may also need to follow these steps:
1. Open the directory C:\Program Files (x86)\InstallShield Installation Information in
Windows Explorer (or C:\Program Files\InstallShield Installation Information in a 32-bit
Windows environment)
2. Open a Windows Search within this directory for files named setup.ini that contain the
text "eXtyles"
15
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3. When the setup.ini file containing this text is found, delete the directory in which it is
located. For example, if the setup.ini file in the folder C:\Program Files (x86)\InstallShield
Installation Information\{E0DB3600-1FB2-11D5-9EC3-0000861CFC58} contains "eXtyles",
delete the entire folder {E0DB3600-1FB2-11D5-9EC3-0000861CFC58}.

Cached files
The Temp folder in a user’s AppData/Local directory can sometimes cache eXtyles files and cause
problems for new installations. Check for eXtyles folders and files there and delete them if they exist.

Applying Patches
Updates to your organization’s eXtyles build may be provided on an as-needed basis with individual
patch files for specific components or data files. These files are compressed in a Zip file and sent via
email. Once unzipped, the patch files should be copied into the directory indicated in the accompanying
email. If a version of the file(s) already exist, the new patch files should replace them (i.e. when
prompted, select Copy and Replace).
Some complicated patch files may be structured within the Zip file so that the entire folder can be
copied over the eXtyles directory, which allows you to quickly and easily merge the sub-folders and copy
over the previous files.

Hardware Keys
Downloading and Installing the HASP Drivers
Some customers must have a hardware key, in the form of a small USB device, inserted into a USB drive
on a computer before installing eXtyles. The first time you install eXtyles on this specific computer, you
must first install the HASP drivers for the key, as follows:
1. Download the HASP drivers from
http://www.extyles.com/drivers/HASP_drivers_latest.zip.
2. Attach your hardware key from Inera to a USB port on the PC.
3. Unzip the downloaded drivers from step 1; inside the resulting folder
Sentinel_HASP_Run-time_ setup, double-click the file HASPUserSetup.exe.
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4. Reboot your PC (at this point, a red light should be glowing on the end of the hardware
key). You can now install eXtyles as instructed.
Be sure the HASP USB drive is inserted and lit up before opening Word and eXtyles.

No Remote Connections with Remote Desktop
eXtyles systems with hardware keys for activation cannot be directly accessed with Remote Desktop.
Accessing servers with Windows Remote Desktop does not allow a session to see a USB key mounted on
a server. If you try to access a keyed version of eXtyles with Remote Desktop, it will fail to run.
The hardware key’s driver specifically disallows recognition of the key during remote-desktop sessions
to prevent an application from having an arbitrary number of instances launched by remote users.
Furthermore, it is also an extension of the general limitation of having a server’s USB hardware available
to remote users. With the exception of printers, most USB devices are not available to remote users
without the installation of additional utilities.
One workaround for using the hardware under the Windows Server 2003/2008 operating system as
a remote user is to have the remote session shadow a console session at the server. This is described
in the Microsoft knowledge base article, How to Connect to and Shadow the Console Session with
Windows Server 2003 Terminal Services.10 We have tested this process at Inera on Windows Server
2003 and found that the key was fully accessible. Under Windows Server 2008, there are other issues
with console access that are documented in the Microsoft article, Changes to remote administration in
Windows Server 2008.11 In Windows 2008 Server, to access session 0 it may be necessary to write your
application as Windows Service or to access directly via the managed iLO/DRAC interface.

Unattended Installations
The eXtyles installer is delivered as an .exe file. Normally the installation and uninstallation process is
run manually. It is possible, though the instructions below, to run a silent or unattended installation and
uninstallation of eXtyles.
An auto-scripted installation or uninstallation of eXtyles requires a custom setup.iss based on the GUID
of your organization’s installer. Please contact eXtyles support for this custom file.
Unattended uninstallations of eXtyles are a little more complicated because Inera cannot deliver
a unsetup.iss file that is ready to use. Instead, the file unsetup.iss file must be created within your
10

http://support.microsoft.com/kb/278845/

11

http://support.microsoft.com/kb/947723
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organization’s local environment to enable a silent uninstall. Please contact eXtyles support for
instructions on how to create this custom file.

Installation
To install eXtyles unattended:
1. Download and unzip the eXtyles installer from the URL posted by Inera. Save the
installer (eXtylesXXXXYYYY.exe; where XXXX is your organization’s acronym and YYYY is
the build number) to your working directory.
2. After receiving the modified setup.iss from Inera, save it to your working directory (the
same as above).
3. Run the following command:

"c:\ZZZZ\eXtylesXXXXYYYY.exe" -a /s /f1"c:\ZZZZ\setup.iss" /
f2"c:\ZZZZ\setup.log"
where ZZZZ is your working directory and XXXX is your organization’s acronym. Note
that (1) all three paths must be full paths (no partial paths are allowed); (2) setup.iss is a
modified version sent by the eXtyles support team; and (3) there is no space after "/f1"
or "/f2" in the command line.
The setup.log file is created upon successful execution of the install.

Uninstallation
To create an unsetup.iss file:
1. Run the following command:

"C:\Program Files (x86)\InstallShield Installation Information\
{12345678-ABCD-1234-ABCD-123456ABCD}\setup.exe" -a /r /f1"c:\
ZZZZ\unsetup.iss" /f2"c:\ZZZZ\setup.log"
where ZZZZ is your working directory and the alpha-numeric string in curly brackets is
your organization’s GUID (sent by Inera). Note that (1) all three paths must be full paths
(no partial paths are allowed); and (2) the root directory is C:\Program Files\ if you are
running 32-bit Windows.
This command records a custom version of unsetup.iss, unique to your local
environment.
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To uninstall eXtyles unattended:
1. Run the following command:

"C:\Program Files\InstallShield Installation Information\
{12345678-ABCD-1234-ABCD-123456ABCD}\setup.exe" -a /s /f1"c:\
ZZZZ\unsetup.iss" /f2"c:\ZZZZ\setup.log"
where ZZZZ is your working directory and the alpha-numeric string in curly brackets is
your organization’s GUID (sent by Inera). Note that (1) all three paths must be full paths
(no partial paths are allowed); and (2) the root directory is C:\Program Files x86\ if you
are running 64-bit Windows.
This command uses the recorded unsetup.iss from step 1 to uninstall eXtyles silently.
Note: Those who are eagle-eyed will note the only difference between the unsetup.iss
creation and playback command lines is "/r" for "record", and "/s" for uninstall
The setup.log file is created upon successful execution of the uninstall.

eXtyles Support and Glance
Glance is a third-party service that Inera uses to screen-share with eXtyles users. Looking at the user’s
screen to observe an issue - and sometimes controlling the screen to explore and resolve the problem helps the support team help you much more quickly and painlessly.
The first time you attempt to connect to Inera’s Glance account, you will be asked to download Glance
software to enable the screenshare. You can learn more about Glance on their Support page12.
Should it be necessary to view the screen of one of your users, we are also happy to work with
applications such as GoToMeeting or WebEx.

Proxy Servers, Firewalls, Security,
and Internet-Dependent Modules
Proxy Servers
Several eXtyles modules query databases and other sources external to eXtyles and the machine on
which it is installed. Some organizations include proxy servers in their network, which affects how these
eXtyles processes connect to the Internet.
12

http://www.glance.net/site/support/support.asp?
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eXtyles takes advantage of Wininet functionality to automatically detect and use your organization’s
proxy server(s) during the following Internet-reliant processes:
•

PubMed Reference Checking and Correction

•

CrossRef Reference Checking and Correction

•

URL Checking

•

Standards Linking and Checking

Network exceptions for user agents
If your network protocols are more restrictive, you may need to set up a network exception for the
user agent used by eXtyles to allow certain Internet-dependent modules to run. The user agent used by
eXtyles is eXtyles WinINet 1.0.

Internet-Dependent Modules
If your organization uses a firewall, you may have to enable access to the URLs which are used by the
following modules:

CrossRef
eXtyles queries CrossRef with this base IP address: https://208.254.38.80
https://208.254.38.80/servlet/query?usr=XXXX&pwd=YYYY&type=q&format=unixref&qdata=%3C%3Fxml%20version%20%3D%20%221.0%22%20encoding%3D%22UTF-8%22%3F%3E%0A%3Cquery_batch%20version%3D%222.0%22%0Axmlns%20%3D%20%22http:%2F%2Fwww.crossref.
org%2Fqschema%2F2.0%22%0Axmlns:xsi%3D%22http:%2F%2Fwww.w3.org%2F2001%2FXMLSchema-instance%22%0A%3E%0A%09%3Chead%3E%0A%09%09%3Cdoi_batch_id%3EeXtyles%20Request%20
395428203%3C%2Fdoi_batch_id%3E%0A%09%3C%2Fhead%3E%0A%09%3Cbody%3E%0A%09%09%3Cquery%20key%3D%22Q1_jrn%22%20enable-multiple-hits%3D%22false%22%20expanded-results%3D%22false%22%3E%0A%09%09%09%3Cyear%3E1996%3C%2Fyear%3E%0A%09%09%09%3Carticle_title%3EGeneral%20score%20tests%20for%20associations%20of%20genetic%20
markers%20with%20disease%20using%20cases%20and%20their%20parents.%3C%2Farticle_title%3E%0A%09%09%09%3Cjournal_title%3EGenet.%20Epidemiol.%3C%2Fjournal_title%3E%0A%09%09%09%3Cvolume%3E13%3C%2Fvolume%3E%0A%09%09%09%3Cissue%3E5%3C%2Fissue%3E%0A%09%09%09%3Cfirst_page%3E423%3C%2Ffirst_page%3E%0A%09%09%09%3Cauthor%3ESchaid%3C%2Fauthor%3E%0A%09%09%3C%2Fquery%3E%0A%09%3C%2Fbody%3E%0A%3C%2Fquery_batch%3E%0A

Note that in the above example, the username (usr) and password (pwd) are XXXX and YYYY
respectively. You would enter your organization’s CrossRef credentials in place of these variables. These
credentials are hardwired into your organization’s CrossRef Checking or Correction module, and can
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be found in XXXLinkRefsCrossRef.xar, located in the eXtyles\XXX\Data\ directory (where XXX is your
organization acronym). Your CrossRef credentials can be found in the following two lines of that file:

-d gstLRP_ServiceLogin

XXXX

-d gstLRP_ServicePassword

YYYY

If you paste this URL into a browser, the browser will show a full XML record for DOI 10.1002/(SICI)10982272(1996)13:5<>1.0.CO;2-9. However eXtyles does not query through a browser — it is a direct HTTP
call from the eXtyles software. The firewall must therefore be configured to allow queries that come
from an application other than a browser.
Access to the base URL shown above must be open for the user of eXtyles. eXtyles uses port 80 for
these queries, so this port must also be open. eXtyles can also be reconfigured to use an alternate port
through a proxy server.
We currently use an IP address, 208.254.38.80, rather than crossref.org to avoid delays in DNS lookups.

PubMed
eXtyles queries PubMed with this URL:

https://eutils.ncbi.nlm.nih.gov/entrez/eutils/
A fully formed query looks like this:

https://eutils.ncbi.nlm.nih.gov/entrez/eutils/esearch.fcgi?te
rm=SCIENCE%5BTA%5D+AND+1728%5BPG%5D+AND+318%5BVI%5D+AND+200
7%5BDP%5D&retmax=3&db=pubmed&email=eXtyles-support%40inera.
com&tool=eXtyles
If you paste this line above into a browser you should get back a result with an ID of 18079386. eXtyles
uses port 80 for these queries. There is no IP address because of the fully formed URL.

Admin training? Admin privileges
If you or your eXtyles user has had Administrator Training and plans to implement configuration changes
to eXtyles in-house, be sure that your user account(s) has full administrator privileges.
eXtyles Administrators should carefully review Inera’s guidelines for modifying and managing in-house
configuration changes: Managing Your eXtyles Configuration: Best Practices for Inera Integration13
13

http://www.inera.com/documentation/eXtyles-Admin-Files-Best-Practices.pdf
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